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Preface

Auto
PREFACE

This manual contains descriptions of the tools which are included in the full version 
of Automation.

The manual is also accessible in an on-line version, which is described in “The On-
line manual” on page 9.

For the moment these tools are:

 1) Convertion of AutoCAD files to Automation projects

 2) Automatic documentation of Symbols in Projects or Libraries

 3) Automatic generation of Graphical Terminal Plans

 4) Automatic generation of Graphical Cable Plans

 5) Automatic Translation of texts in projects

Ideas for other tools are welcome. Please refer to our e-mail address on the title 
page.
mation Tools
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The manual for PC|SCHEMATIC Automation 
both exists in a printable version and as an on-
line manual.

This part describes the use of the on-line 
manual.

The On-line manual





The On-line manual

Auto
THE ON-LINE MANUAL

When using this on-line manual, you have the benefit of reading the manual 
directly on the screen while working with the program. The contents is identical to 
the A4 printable manual, only have the pages been adapted for reading on the 
screen.

OPENING THE ON-LINE MANUAL

To open the On-line manual choose Help and select the manual.

THIS CHAPTER DESCRIBES

— OPENING THE ON-LINE  MANUAL ..................................................................(P. 9)
— THE TABLE OF CONTENTS..........................................................................(P. 10)
— THE BUTTONS IN THE ON-LINE  MANUAL.....................................................(P. 10)
— ZOOMING AND ADAPTING TO YOUR SCREEN...............................................(P. 10)
— DIRECT ACCESS TO THE INDEX ..................................................................(P. 11)

— RETURNING TO Automation ..................................................................(P. 11)
— PRINTING FROM THE ON-LINE MANUAL .......................................................(P. 11)

Click di-

Up and

rectly to

About the elec-
tronical manual

Click to view a
chapter

Fit the manual
to your screen

Page no.

Return

down

Zoom

Index

Click to view the
sub-chapters

Click to jump to
other chapters

Click on the
+ to see the
sub-chapters
mation Tools
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The On-line manual
THE TABLE OF CONTENTS

In the left-hand side of the manual, you can click 
directly on the section you wish to read.

A + in front of a section means that the chapter 
is divided into subsections.

When you click directly on a title of a section, 
the chosen section is displayed.

You can adjust the size of the table of 
contents on the screen. This is done 
by pointing on the line between the 
table of contents and the manual text, 
and then drag the line to either the left 
or the right.

You can turn the displaying of the 
table of contents on and off by pres-
sing [F5].

THE BUTTONS IN THE UPPER-RIGHT CORNER

In the upper-right corner of the on-line manual, 
you will find these four buttons.

When you click the ? button, you enter this 
chapter about using the on-line manual.

If you click the Return button, you jump back 
to the last page that you have viewed in the on-
line manual.

When you click the up and down buttons, you 
leaf one page up or down respectively. You can 
also use the [PageUp] and [PageDown] but-
tons on the keyboard.

ZOOMING AND ADAPTING TO YOUR SCREEN

When you open the on-line manual initially, it is opened to a size fitting your screen. 
If you need to zoom in on a detail in the manual, you click the Zoom button in the 
upper-left corner of your screen.

To re-size the on-line manual to fit your screen, you click the Fit in Window button 
on the upper part of the screen, or press [Ctrl+0].

Table of contents Manual

Drag the line to the right or to the left

About the elec-
tronical manual

Return to the last
page you read

One page up

One page down
Automation Tools
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DIRECT ACCESS TO THE INDEX

On the right-hand side of the on-line manual, you have direct access to the index.

To find an explanation about fx. the selection function, you click S index letter in 
the right-hand side of the manual. This then looks up under S in the index. Now 
click on the dotted line after the word Selection, to bring up to the desired informa-
tion.

Please note, that it is important that the cursor on screen has the 
appearance of a hand with a pointing index-finger, when you click the 
dotted line — or the page number. If this is not the case, you zoom in 
on the text, and therefore can no longer see the full page on screen.

Click the Fit in Window button or press [Ctrl+0] to restore full page view.

RETURNING TO Automation

In order to return to Automation, you 
just click on its program Windows but-
ton at the bottom of your screen — or 
press down the <Alt> button while 
pressing the <Tab> button.

The reason why you have to change back and forth in this way, is because that the 
manual is a document in the independent program Adobe Acrobat reader.

PRINTING FROM THE ON-LINE MANUAL

If you wish to read the manual on print, it is recommended to see the printed 
manual. To print out directly from the on-line manual, just click the Print button on 
the Acrobat program, and specify what to print out.

Please note, that the on-line manual buttons will also be printed.

Click here
mation Tools
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In PC|SCHEMATIC Automation you can automa-
tically convert AutoCAD files — with attached 
intelligence — to PC|SCHEMATIC Automation 
project files.

This is the subject of this chapter.

Converting AutoCAD files
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Auto
CONVERTING AUTOCAD FILES

In Automation it is possible to import AutoCAD files (DWG/DXF files), and convert 
these to Automation projects.

It is also possible to attach information from the original AutoCAD objects to the 
created Automation projects intelligently. Export from Automation to the DWG/
DXF format is also possible.

The setting of import and export parameters takes place via the tool DWG/DXF 
map options, which is described in this chapter.

WHAT IS A MAP FILE?
When you import files of another file format in Automation, or export files from 
Automation to another file format, this can be done via a so-called map file.

In this map file, it is specified how objects in the one file format, is translated/map-
ped to objects in the other format.

If you have detailed knowledge about Automation, as well as about the other pro-
gram you wish to convert to/from, you can change the parameters for how the 
translation takes place from the one program to the other.

In the following it is showed how you can change the settings for import of DWG/
DXF files.

THIS CHAPTER DESCRIBES

— WHAT IS A MAP FILE? ..............................................................................(P. 15)
— THE WORK PROCESS WHEN CONVERTING DWG/DXF FILES ........................(P. 16)
— OPENING AND EDITING MAPFILES ...............................................................(P. 18)
— WHICH FUNCTIONS ARE TRANSFERRED? ....................................................(P. 19)
— IMPORT OF DWG/DXF FILES.....................................................................(P. 20)
— DWG/DXF MAP SETTINGS.........................................................................(P. 21)
— IMPORTING DWG/DXF FILES IN EXISTING PROJECTS ..................................(P. 43)
— IMPORTING DWG/DXF FILES IN SYMBOLS..................................................(P. 44)
— EXPORTING DWG/DXF FILES....................................................................(P. 46)

DWG/DXF file Automation file

Loaded MAP file

MAP file on disk

Automation
mation Tools
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THE WORK PROCESS WHEN CONVERTING DWG/DXF FILES

When you convert DWG/DXF files, one part of this work takes place in Automa-
tion, and another takes place in the tool DWG/DXF map options:

Importing the DWG/DXF file is done in Automation

Import of DWG/DXF files in Automation, takes place via the Open dialog box in 
Automation — via a selected map file.

Changes in the map file are made in DWG/DXF map options

When you wish to make changes in the applied map file, enter the tool DWG/DXF 
map options, from where changes in map files are made.

Repeated refinement of mapfiles for better import

When you import DWG/DXF files, this is a gradual refinement process:

 1) Import the DWG/DXF file in Automation by choosing File => Open

 2) In the dialog box Open: Choose the file type *.dwg or the file type *.dxf at 
the bottom of the dialog box, click on the file and click on Open

 3) The program presents a new Open dialog box: Click on the mapfile you wish 
to use, and click on Open

 4) The file is now created as a Automation project: Analyse the created file in 
Automation, and see which blocks (symbols) and texts that could be 
imported more intelligently

HERE IT IS DESCRIBED HOW TO IMPORT A DWG/DXF FILE IN A NEW Auto-
mation PROJECT.
— PLEASE ALSO SEE “IMPORTING A DWG/DXF FILE IN AN EXISTING PRO-
JECT” ON PAGE 43 AND “IMPORTING DWG/DXF FILES AS SYMBOLS” ON 
PAGE 44.

IF YOU DO NOT HAVE A MAP FILE, YOU CAN USE THE MAPFILE ACAD.MAP IN 
THE FOLDER Pcselcad FOR A START.
Automation Tools

age 16



Converting AutoCAD files

Auto
 5) Then open DWG/DXF map options — see “Opening and editing mapfiles” 
on page 18 —, adapt the mapfile according to your observations and save 
the mapfile, for instance under a new name

 6) Now start again from step 1, and continue this repetitive process until you 
have made sure that you have transferred/inserted as much intelligence in 
the Automation project as you wish — please refer to the figure below

See the result

Import DWG/DXF drawing

Make the necessary changes in

Save the changed mapfile

the Mapfile via Map tools

Import DWG/DXF drawing
using the updated mapfile

(via selected Map file)

In Automation In DWG/DXF map options
mation Tools
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OPENING AND EDITING MAPFILES

When you open the tool DWG/DXF map options to make changes in a mapfile 
based on an existing DWG/DXF file, do the following:

 1) Choose Tools => DWG/DXF map options — to open a mapfile, and adjust 
it according to the file you wish to import

 2) In the dialog box DWG/DXF map options: Click on Open — to open a map-
file

 3) In the dialog box Open: Select a mapfile, and click on Open

You can now edit the mapfile via the different tabs in the dialog box — as described 
in “DWG/DXF map options” on page 21.

When you wish to fetch information from an existing AutoCAD file, in order to adapt 
the mapfile more efficiently, do the following (Skip to step 9 if this is not the case):

 4) In the dialog box DWG/DXF map options: Click on Load drawing

 5) In the dialog box Open file: Select the DWG/DXF file you wish to fetch infor-
mation from, and click on Open

 6) You now get a status of the contents of the opened DWG/DXF file:

 7) Click on Close. When you wish to see this information again, click the Sta-
tus button at the bottom of the dialog box DWG/DXF map options.

 8) In the dialog box DWG/DXF map options: You can now adjust the settings 
in the opened mapfile according to the contents of the file you wish to con-
vert. You can do this based on the pieces of information from the selected 
DWG/DXF file you find in the left-hand side of the different tabs in the dialog 
box.
Automation Tools
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The elements written in grey in the left-hand side of the dialog box has an 
existing translation in the mapfile, while the elements written in black has no 
existing translation in the mapfile (a default parameter will be used). — Read 
more about the options on the individual tabs in “DWG/DXF map options” on 
page 21.

 9) Click on Save when you have made the desired changes in the mapfile.
You do not have to close the dialog box, because you probably will need to 
make changes in the mapfile more than once.

 10) Now return to Automation, import the DWG/DXF file again, and evaluate 
the result.

WHICH FUNCTIONS ARE TRANSFERRED FOR DWG/DXF FILES?
When converting, common functions for the program you import from and Auto-
mation will be transferred.

Furthermore a number of other functions/information can be transferred intelli-
gently, as described in “DWG/DXF map options” on page 21.

When importing objects, which Automation can not handle, it is recommended to 
"explode" the drawing before importing. Automation can not handle coordinates 
— such as line lengths — on more than two kilometers.

Importing ground plans

When you wish to import ground plans, it is recommended to insert these as OLE 
objects in the Automation project. If the inserted OLE object is linked to the Auto-
mation project, you furthermore have the advantage that it is updated automati-
cally in Automation, when it is updated in AutoCAD. Read more about this in 
"Inserting files from other programs / OLE" in the Automation manual.

If you have difficulties importing DWG or DXF files, please contact your local hot-
line.

Has no translation Has a translation
mation Tools
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IMPORTING DWG/DXF FILES

There are three different ways to import DWG/DXF files in Automation:

a) You can start a new project by opening a DWG/DXF file — see “The work 
process when converting DWG/DXF files” on page 16

b) You can import a DWG/DXF file in an existing project by importing them via 
the Page menu — see “Importing a DWG/DXF file in an existing project” on 
page 43

c) You can import a DWG/DXF file as a symbol, and then work with the symbol 
as an ordinary symbol in your projects — see “Importing DWG/DXF files as 
symbols” on page 44

PREPARING THE DWG/DXF FILE BEFORE IMPORTING

IT IS A GOOD IDEA TO ADAPT THE DWG/DXF FILE BEFORE IMPORTING IT, 
SO THAT IT ONLY CONTAINS EXACTLY WHAT YOU NEED.
Automation Tools
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DWG/DXF MAP OPTIONS

In the dialog box DWG/DXF map options you can adapt mapfiles, in order to get 
the best possible mapping of the imported files.

This section describes the possibilities you have on the different tabs in the dialog 
box.

— See “The work process when converting DWG/DXF files” on page 16 and “Ope-
ning and editing mapfiles” on page 18 for general information about converting 
DWG/DXF files and working with mapfiles.

CHOOSING IMPORT OR EXPORT

In the upper left-hand corner of the dialog box 
DWG/DXF map options, you choose whether to 
edit the settings for Import of files to Automation, 
or to edit the settings for Export from the program to the DWG/DXF format.

Independent Import and Export settings necessary

The reason why you have to specify whether to change import or export settings, is 
that you can not always use the same settings both ways.

For instance you can choose to convert both of the two DWG/DXF LineStyles DOT 
and HIDDEN to Automation linestyle 2. Therefore, when you need to convert the 
other way, the program does not know whether to translate the linestyle 2 from 
Automation to the linestyle DOT or HIDDEN.

THIS CHAPTER DESCRIBES

— CHOOSING IMPORT OR EXPORT.................................................................(P. 21)
— INTELLIGENT IMPORT OF DWG/DXF FILES .................................................(P. 22)

— THE BUTTONS IN THE DIALOG BOX DWG/DXF map options..................(P. 22)
— MAKE MORE ROOM ON THE LEFT-HAND SIDE OF THE TAB ............................(P. 23)
— THE TAB APPLICATION...............................................................................(P. 24)
— THE TAB COLOR .......................................................................................(P. 27)
— THE TAB LINESTYLES ................................................................................(P. 29)
— THE TAB LAYER(MAP) ...............................................................................(P. 31)
— THE TAB TEXTS .........................................................................................(P. 33)
— THE TAB BLOCKDEFS................................................................................(P. 34)
— THE TAB ATTDEFS ....................................................................................(P. 36)
— THE TAB LAYER(DEF) ................................................................................(P. 38)
— THE TAB ADVANCED..................................................................................(P. 40)
mation Tools
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DWG/DXF map options
Therefore independent import and export settings are needed.

— Read more about export from Automation to the DWG/DXF format in “Expor-
ting DWG/DXF files from Automation” on page 46.

INTELLIGENT IMPORT OF DWG/DXF FILES

In the dialog box DWG/DXF map options, you will find two types of tabs:

 1) Tabs applied for traditional translation/mapping: Translation of e.g. one color 
in the DWG/DXF file to one color in the Automation project. Or mapping one 
linestyle to another, or one text to another, or transferring objects from one 
layer to another.

 2) Tabs for transferring/creating intelligence: Here you can for instance specify 
which blocks that must be translated to which symboltypes in the Automa-
tion project. Or for instance which text attributes in the DWG/DXF file that 
must be translated to which symbol texts or datafields in the Automation 
project.

Read more about these options in the sections about the various tabs.

THE BUTTONS IN THE DIALOG BOX DWG/DXF MAP OPTIONS

There are the following buttons in the dialog box:

The button Close

Click here and DWG/DXF map options is closed. The specified 
changes are not saved.

The button New

Click here to create a new mapfile from scratch.

The button Open

Click here to open an existing mapfile.

The buttons Save and Save as

Click here to save the settings in the mapfile.

IMPORTING DWG/DXF FILES

THIS CHAPTER MAINLY FOCUSES ON IMPORT OF DWG/DXF FILES.

Tabs for traditional
translation/mapning

Tabs for transferring
intelligence
Automation Tools

age 22



DWG/DXF map options

Auto
The button Load drawing

Click here to load data from an existing DWG/DXF file — as described in “Opening 
and editing mapfiles” on page 18.

MAKING MORE ROOM FOR THE LEFT-HAND SIDE OF THE TAB

When you need more space for the left-hand 
side of the dialog box, place the mouse cur-
sor over the vertical line between the left-
hand and the right-hand side of the tab. Then 
drag the dividing line to the desired position.
mation Tools
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THE TAB APPLICATION

On the tab Application you specify the general settings for the mapping.

The file(s) contains one project page only

Select The file(s) contains one project page only, if the DWG/DXF file only con-
tains one single project page.

Interpret all pages in a file catalog as one project

AutoCAD can only handle one project page in each file. Automation can handle 
all necessary project pages in one file.

Therefore, when you save all AutoCAD files attached to the same project in the 
same folder, you can — during the conversion to the Automation format — auto-
matically place these files in the same Automation project.

To do this, choose Merge all files in folder to one project.

DWG/DXF FILES FROM COMPETING ELECTRICAL APPLICATION PROGRAMS

ON THE TAB APPLICATION YOU CAN HAVE THE OPTION TO CHOOSE BET-
WEEN DIFFERENT TYPES OF AUTOCAD FILES. THIS IS BECAUSE THE INTER-
PRETATION OF THE AUTOCAD FILES WILL BE DIFFERENT DEPENDING ON 
WHICH PROGRAM THE DWG/DXF FILES ARE CREATED FROM.
IT IS POSSIBLE TO BUY ADDITIONS TO THIS CONVERSION PROGRAM, WHICH 
MAKES IT POSSIBLE TO CONVERT AUTOCAD FILES FROM COMPETING ELEC-
TRICAL APPLICATIONS.
PLEASE CONTACT DPS CAD-CENTER APS FOR FURTHER INFORMATION.
Automation Tools
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Page number in filename

During the conversion process, the file name for the DWG/DXF file is used as page 
number/name in the Automation project. When the name of the file is ABC12, the 
name of the page in the project therefore becomes ABC12.

If you select Pagenumber in filename, the program takes the last digits from the 
file name, and only use these as page number. When the name of the file is 
ABC12, the name of the page in the project therefore becomes 12.

Convert lines to electrical lines

If you choose Convert lines to electrical lines, all lines in the DWG/DXF file are 
converted to be conducting lines in the created Automation project.

Applied symbol library for conversion

During the conversion it is possible to specify that a block in the AutoCAD file must 
be replaced with a predefined symbol in the created Automation project.

When the program meets a block during the conversion process, it is examined 
whether this block exists in the symbol library. If it exists in the library, the symbol 
from the library is inserted in the created Automation project. If it is not in the 
library, a new symbol is created in the project, based on the block.

In order to make this function, the symbol in the selected symbol library must have 
the same name as the block in the AutoCAD file.

You must also specify in which folder these special Automation symbols exists.

When is this necessary?

This can for instance be necessary if the program has not been able to insert con-
nection points automatically on a symbol, or if you for instance wish to specify that 
the lower connection point on a terminal symbol has an IO status set to Output.

When you have converted a DWG/DXF 
file, there can be some symbols which 
have not been assigned connection 
points — or that has incorrectly placed 
connection points. This will be spotted 
quickly due to the parked lines next to 
these symbols.

Specifying the location of the symbol
library

The symbol library is selected by clicking 
on the Browse button next to Conver-
sion symbol library, clicking on the fol-
der in which the symbol library is placed, 
and clicking OK.

Creating a symbol in the symbol library

When you have translated a DWG/DXF file, and have realised that you wish to cre-
ate a symbol as the translation for a specific block in the file, do the following in 
Automation:
mation Tools
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 1) Click on the Symbols and the Symbol menu button

 2) In the Symbol menu: Click on the Project symbols button, click on the 
symbol, and click on the Open symbol button

 3) In the Symbol editor: Adapt the symbol, save it in the symbol library folder, 
and choose File => Close

 4) In the Symbol menu: Click Cancel — in order not to get the symbol in the 
cross-hairs

Repeat this procedure for all symbols in the project, for which this is necessary.

2a) Click here 2b) Click on the symbol 2c) Click here
Automation Tools
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THE TAB COLOR

On the tab Color you specify how the colors in the DWG/DXF file shall be inter-
preted to the different colors in Automation.

Mapping parameters for colors in Automation

In Automation there are number codes for each object type, specifying for 
instance the color or line type of the object.

On the tab above you can specify that for instance the AutoCAD color 7 is trans-
lated to the color 0 in Automation.

Add, Remove and Edit

When you click on a line in the dialog box above, you can click on Edit, and you get 
the option to change the settings in the line.

If you click on Remove, the selected line is deleted. If you click on Add, a new line 
is added, on which you can type in new information.

Names on colors in Automation

You have the following color options in Automation:

Code Color Code Color

0 Black 1 Red

2 Green 3 Yellow

4 Blue 5 Magenta red

CODES FOR COLORS IN Automation
mation Tools
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Force symbol COLOR to

When you select Force symbol COLOR to you get the option to type in a color, 
that all symbols will be drawn with in the created Automation project — for 
instance the color black.

Force project COLOR to

When you select Force project COLOR to you get the option to type in a color, 
which all lines, circles and texts in the created Automation project will be drawn 
with.

6 Cyan 7 White

8 Light red 9 Light green

10 Brown 11 Light blue

12 Light magenta red 13 Light cyan

14 Not displayed on print

AUTOMATIC MAPPING OF OBJECT TYPES TO FIXED VALUES

AT THE BOTTOM OF SOME OF THE TABS YOU CAN, FOR EACH INDIVIDUAL 
OBJECT TYPE, CHOOSE WHETHER THE DEFINITIONS IN THE FILES AND/OR 
THE PROJECT DRAWINGS ALWAYS MUST BE CONVERTED TO A FIXED VALUE.
THESE SETTINGS ONLY APPLIES FOR IMPORT TO Automation.

Code Color Code Color

CODES FOR COLORS IN Automation
Automation Tools

age 28



DWG/DXF map options

Auto
THE TAB LINESTYLE

On the tab Linestyle you specify how the linetypes in the DWG/DXF file shall be 
converted to the different linetypes in Automation.

Changing mapping for linestyles

When you wish to change the name of a linestyle, or change what a linestyle is 
translated to, click on Edit. You then get the option to edit both fields in the line. You 
first get the option to edit the Other application field, then the PCschematic field.

For each object type in Automation there exists a number code specifying e.g. its 
color or linestyle. The significance of these number codes is described in “Linesty-
les in Automation” on page 29.

Remove and Add

When you wish to remove a line, click on the line, and click on the Remove button.

Click on Add to add new lines.

Linestyles in Automation

Automation has the following linestyles:

Code LineStyle Code LineStyle

0 Solid 1 Dash

2 Dot 3 DashDot

4 DashDotDot 5 DashDotDotDot

6 DashDashDot 7 DashDashDotDot

8 DashDashDotDotDot 9 FinDot

CODES FOR LINESTYLES IN Automation
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Force symbol LINESTYLES to

If you select Force symbol LINESTYLES to, you get the option to type in a line-
style, which all symbols in the created Automation project will be drawn with — for 
instance the linestyle Solid.

Force project LINESTYLES to

If you select Force project LINESTYLES to, you get the option to type in a line-
style, which all lines in the created Automation project will be drawn with.

14 SolidBox 15 EmptyBox

21 VerticalBox 22 HorizontalBox

Code LineStyle Code LineStyle

CODES FOR LINESTYLES IN Automation
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THE TAB LAYER(MAP)
On the tab Layer(Map) you can specify that the contents of specified layers in the 
DWG/DXF file shall be placed on specified layers in the Automation project.

The different layers are represented by their layer numbers:

Adding a new layer to the mapfile

To move a layer from the loaded drawing to the right side of the dialog box, just 
click on the layer name, and drag it to the right side of the dialog box. Hereby a new 
line is created, and you get the option to choose a layer number.

Force symbol LAYER to

Click on Force symbol LAYER to, and set the value to 0.

By doing this you specify that all symbol definitions will be placed in layer 0, which 
must be the case in all Automation projects.

Drag the layer from
left to right
mation Tools
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Force project LAYER to

If you wish to place all project drawings on a specified layer in the Automation pro-
ject, click on Force project LAYER to, and type in the name of the relevant layer.

LAYER 0 IN Automation
PLEASE NOTE THAT LAYER 0 IN Automation IS USED FOR DEFINITIONS.
IF DRAWINGS ARE PLACED IN LAYER 0 IN Automation, YOU WILL THERE-
FORE NOT BE ABLE TO WORK ON THEM SUCCEDINGLY.
IF YOU HAVE PLACED DRAWINGS ON LAYER 0 IN THE DWG/DXF FILE, THESE 
MUST THEREFORE BE PLACED IN LAYER 1 (OR IN ANOTHER LAYER) IN THE 
Automation PROJECT. OTHERWISE, YOU WILL NOT BE ABLE TO CONTINUE 
WORKING ON THESE DRAWINGS.
Automation Tools
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THE TAB TEXTS

On the tab Texts you specify whether certain texts in the DWG/DXF file shall be 
converted to other texts in the Automation project:

When for instance you know that %%d in the DWG/DXF file must be translated to 
the special character ø in the Automation project, you specify this on the tab 
Texts — as displayed above.

Add, Remove and Edit

You can add, remove and edit texts as described in “Add, Remove and Edit” on 
page 27.
mation Tools
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THE TAB BLOCKDEFS

When converting DWG/DXF files, the blocks in the file are converted to symbols in 
the Automation project.

In order to be able to make use of the special options attached to the different sym-
bol types in Automation, you can furthermore specify which symbol types to 
assign to the various symbols. This takes place on the tab BlockDefs:

See the blocks in the loaded drawing

When you have loaded a drawing — as described in “Opening and editing mapfi-
les” on page 18 — you can see which blocks exists in the loaded drawing in the 
left-hand side of the dialog box. You can then specify which symbol types these 
blocks shall be assigned in the Automation project during the conversion. This is 
done by clicking on the block name in the left-hand side of the dialog box, and then 
dragging it to the desired box in the right-hand side of the dialog box.

When a block name is dimmed in the left-hand side of the dialog box, this is 
because the name is already placed in one of the boxes in the right-hand side.

To get to the lower part of the boxes in the dialog box, just drag the elevator in the 
right-hand side of the tab.

Converting blocks in the example above

In the displayed example above, you can for instance see:

- The block 220S is assigned the symbol type Relay, and is therefore automati-
cally assigned a reference cross / contact mirror in the Automation project

- The block 240S is assigned the symbol type Open, and therefore automatically 
gets a reference to its relay in the Automation project

Click here and drag downwards to see the rest
— or maximize the dialog box
Automation Tools
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- The block 6S is assigned the symbol type Terminal, and will therefore automa-
tically be included in terminal lists and graphical terminal plans in the Automa-
tion project

Blocks as drawing headers - or Exploded

On the lower part of the tab, you can also specify that a block must be understood 
as a drawing header, or that a block must be exploded. When a block is exploded it 
is converted to lines, circles and texts on the page.

Symbols with the status Ignored

When you choose Ignored, the status for Mechanical and Electrical for the sym-
bol is automatically disabled in the Automation project. This can be seen in the 
dialog box Symbol article data on the tab General. This has the consequence 
that the symbol will neither appear on electrical nor mechanical lists in Automa-
tion.

Symbols which are deleted during the conversion process

When you choose Delete symbol, the symbol is automatically deleted after the file 
has been converted.

This option can for instance be applied when the DWG/DXF file contains connec-
tion dots, which are created as symbols. Because these connection dots are 
created automatically in Automation, these should be deleted from the project file. 
— Please also refer to “Doughnut count” on page 40.

Defined text attributes in the individual blocks

When you click on a block in the left-hand side of 
the tab, which has defined text attributes, these text 
attributes are displayed at the bottom of the dialog 
box.

— Read more about text attributes in “The tab Att-
Defs” on page 36.
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THE TAB ATTDEFS

On the tab AttDefs you can specify which text types or datafields in Automation 
shall contain the different text attributes in the AutoCAD file.

This is done following the same directions as 
described in “The tab BlockDefs” on page 34.

When you drag in the elevator, you can 
furthermore see the text types displayed to 
the right.

Different text attributes

The different text attributes can for instance 
be:

- All texts for Symbol article data

- All texts for Connection data

- System data fields

Converting the attributes in the example above

In the displayed example above, you can for instance see:

- The text attribute BET1 will be interpreted as the Symbol name for a symbol in 
the Automation project.

- The text attribute UTTAG1 will be interpreted as the Connection name for a 
symbol. For each connection name the program meets in a block in the Auto-
CAD file, the program automatically creates a connection point on the symbol 
in the Automation project.

The prompt when placing the block in AutoCAD
Automation Tools
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- The text attribute C10 will be interpreted as Project data, and the program will 
therefore automatically create a project data datafield with the name C10 in the 
Automation project. This datafield will be seen in the dialog box Project data 
for the project.

The Prompt from the AutoCAD file is displayed as a help

For some of the AutoCAD text attributes, there is displayed a text, which is the 
prompt that appears when placing the block in AutoCAD. These is meant as a help 
for correct conversion of the text attributes.
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THE TAB LAYER(DEF)
On the tab Layer(Def) you specify which layers in the AutoCAD file that contains 
the different diagram elements.

When different types of information is placed on specified layers in the DWG/DXF 
file, the program can fetch this information, and attach it intelligently to the relevant 
objects in the Automation project — such as e.g. symbol names, connection 
names or symbol types.

When wire numbers are placed on a specified layer, these are hereby created 
automatically as wire number symbols in the Automation project, and are placed 
on the correct line.

Or, when for instance terminals are placed on a specified layer in the DWG/DXF 
file, the program automatically creates all blocks on this layer as symbols with the 
type Terminal in the Automation project. Or, if the drawing header is placed on a 
specified layer, all of the contents on this layer is created as a drawing header in 
the Automation project.

THE TAB LAYER(DEF) IS ONLY DISPLAYED FOR SOME ELECTRICAL APPLI-
CATION PROGRAMS

BECAUSE ONLY SOME ELECTRICAL APPLICATION PROGRAMS PLACES DIFFE-
RENT OBJECT TYPES ON DIFFERENT LAYERS, THIS TAB IS ONLY DISPLAYED 
FOR AUTOCAD FILES FROM SOME ELECTRICAL APPLICATION PROGRAMS.
THIS TAB WILL NOT BE AVAILABLE IN A NORMAL INSTALLATION.
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age 38



DWG/DXF map options

Auto
Current path numbers are transferred intelligently

When there are current path numbers on a specified layer, these can be transfer-
red to Automation as current path numbers — which can be adjusted from the tab 
Settings => Page data => References succeedingly, if necessary.

Delete layer

When you drag a layer name to the Delete layer box, none of the contents on this 
layer is included in the Automation project.

’Layer one’ layer

All layers, which are placed here, are automatically placed on layer 1 in the Auto-
mation project.
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Page 39



P

DWG/DXF map options
THE TAB ADVANCED

The last tab in the dialog box, is the tab Advanced.

Here you can make the following settings:

Import scale

When you wish to scale the DWG/DXF file during the conversion, you can specify 
to scale the drawing in e.g. 1:10, in the field Import scale.

Lines

Under Lines you have two options:

Doughnut count

Because Automation automatically places connection dots (doughnuts), it is a 
good idea to delete these from the DWG/DXF file, if the file contains doughnuts. If 
you know that the doughnuts are drawn as for instance 7 or 13 line segments, you 
can specify this here.

Hereby the program automatically deletes all POLYLINES drawn with for instance 
7 or 13 line segments.

If these doughnuts are created as symbols in the project, these are deleted as 
described in “Symbols which are deleted during the conversion process” on 
page 35.

Set connection points to external when dotted lines

If you select Set connection points to external when dotted lines, the connec-
tion points for terminals are automatically set to IO status Output if these are con-
nected to a dotted line.
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Texts

Under Texts you have these options:

Signal ref. text

When you type in a text in this field, this text is inserted as pre-text for all signal 
references in the project. When for instance you write Page, this text is placed at 
the beginning of the signal reference.

Decode reference designations in free texts

When you select Decode reference designations in free texts, all free texts in 
the DWG/DXF file are examined for reference designations.

When reference designations are found in texts — this is if the texts contains the 
characters "=" and/or "+" — these will be understood as reference designations in 
the Automation project.

In symbol names this means that the reference designation is deleted from the 
symbol name, and then attached intelligently to the symbol, as the reference desig-
nation for the symbol in the Automation project.

When there is a free text on the page containing a reference designation, this text 
is deleted from the page, and attached intelligently as the reference designation for 
the page in the Automation project.

Decode "-" (minus) as page number

In some electrical application programs the character "-" (minus) is used for repre-
senting the name of the page in symbol names. When it for instance says -K1 on 
page 10 in the file, this means that the name of the symbol is 10K1. Correspon-
dingly, if it says -K1 on page 11, this means that the name of the symbol is 11K1.

When you choose Decode "-" (minus) as page number, the names of these two 
relay coils are changed automatically to 10K1 and 11K1 respectively during the 
conversion process.

Text width/height ratio

The ratio between text width and text height can vary from one text font to another.

When you translate a text in a DWG/DXF file to a text in Automation, it can there-
fore be necessary to specify a ratio between text height and width. Hereby you can 
for instance avoid that texts during the conversion will take up too much space, and 
therefore overlap symbols in the project.

The ratio between text width and height is specified in the field Text width/height 
ratio.

It can be necessary to make this adjustment when the two systems does not use 
the same text fonts.

Symbols

Under Symbols you have these options:
mation Tools
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Optimize symbol box

Some blocks have their reference points in (0,0), which can be quite far from the 
block drawing. When you select Optimize symbol box, reference points are pla-
ced on the symbol drawing.

Explode all blocks (No symbols)

When you select Explode all blocks (No symbols), all blocks in the DWG/DXF 
file are converted to lines, arcs and texts in the created Automation project. 
Hereby you get a project containing no symbols.
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IMPORTING A DWG/DXF FILE IN AN EXISTING PROJECT

When you have a Automation project open and wish to import a DWG/DXF file, do 
the following:

 1) Click on the Page menu button.

 2) In the Page menu: Click where you wish to insert the file as a new page and 
click Insert — or click on Add to insert this page as the last page in the pro-
ject. — Read more about the Page menu in "The Page menu" in the Auto-
mation manual.

 3) In the dialog box Page function: Click on Standard/Project file, and then 
click on OK.

 4) In the dialog box Open: Click on the folder where you have placed the file, 
and choose Acad files (*.dwg) or Dxf files (*.dxf) as Filetype, click on the 
file, and then on Open. 

 5) A new Open dialog box appears: Select a mapfile, and click on Open.
mation Tools
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 6) In the dialog box Rename symbols: Make the required settings — see 
"Intelligent copying of areas" in the Automation manual if necessary —, and 
click OK.

Opening more than one DWG or DXF file

 7) You have now loaded the DWG/DXF file, and are still in the Page menu. 
When you need to load more DWG/DXF files, repeat the same procedure for 
these files.

 8) When you have finished loading files: Click OK to leave the Page menu.

IMPORTING DWG/DXF FILES AS SYMBOLS

It is also possible to fetch a DWG/DXF file as a symbol. This has the advantage 
that you can move it as a symbol, and that you therefore do not risk to make chan-
ges in it by accident.

When you wish to load a DWG/DXF file as a symbol, do the following:

 1) Click on the Symbols button and then on the Symbol menu button.

 2) In the Symbol menu: Click on Create new Symbol.

 3) In the Symbol editor: Click on the Open button.

 4) In the dialog box Open: Choose Acad files(*.dwg) or Dxf files (*.dxf) in the 
Filetype field, find the file and click Open.

 5) In the dialog box Open map file: Select the desired mapfile and click Open.

 6) The DWG/DXF file is now loaded in the Symbol editor: Make the necessary 
changes — if necessary — and choose File => Save as.

 7) In the dialog box Symbol Settings: Specify the symbol settings for the sym-
bol — as described in "Saving the symbol" in the Automation manual — and 
click OK.

 8) In the dialog box Save as: Give the symbol a name, choose which folder to 
save it in, and click Save.

USING DWG/DXF map options
WHEN YOU IMPORT INTO AN EXISTING PROJECT, YOU CAN ALSO APPLY THE 
TOOL DWG/DXF map options FOR ADAPTING THE APPLIED MAPFILE, AS 
DESCRIBED IN “THE WORK PROCESS WHEN CONVERTING DWG/DXF FILES” 
ON PAGE 16.
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 9) In the Symbol editor: Choose File => Close — to leave the Symbol editor.

 10) In the Symbol menu: The symbol is displayed.

 11) Click on OK, and you get the loaded drawing in the cross-hairs as a sym-
bol. Click where you wish to place the symbol in the active project.

Please note that the program automatically places a reference point in the lower 
left-hand corner, where all texts are placed also. The symbol is a normal symbol, 
with selection in the reference point. — Read more about this in "Symbol types" in 
the Automation manual.

When you wish to edit the loaded symbol — or save it in a symbol library — you 
can choose Edit in the Symbol menu. Here you can edit and save the symbol as 
for normal symbols.

— Read more about working with symbols in "Symbols" in the Automation 
manual, and about how to edit symbols in "Creating Symbols" in the Automation 
manual.
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EXPORTING DWG/DXF FILES FROM Automation

When exporting objects which the DWG/DXF format can not handle, Automation 
uses objects known by the DWG/DXF format when possible.

Electrical properties can not be transferred via the DWG/DXF format. Electrical 
lines will therefore be exported as "simple lines".

When you wish to export DWG/DXF files from Automation, you have two options:

 1) Exporting a project as a DWG/DXF file — see “Exporting projects as DWG/
DXF files” on page 46.

 2) Exporting a symbol as a DWG/DXF file — see “Exporting symbols as DWG/
DXF files” on page 47.

— Please also see “Map settings for Export of DWG/DXF files” on page 48.

Exporting projects as DWG/DXF files

When you wish to export a Automation project as a DWG/DXF file, do the follo-
wing:

 1) Choose File => Save as, set the filetype to Acad files (*.dwg) or Dxf files 
(*.dxf), type in a file name, and click on Save.

 2) You now enter the dialog box Export of a PCschematic project:

In addition to choosing which version to export to, you here have the follo-

Choose which version
to export to
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wing options:

Select the desired settings, and click OK.

 3) In the dialog box Open mapfile: Choose the desired mapfile, and click 
Open.

The chosen part of the project is now saved in the DWG/DXF format.

Exporting symbols as DWG/DXF files

It is also possible to save a symbol as a DWG or a DXF file:

 1) Click in Symbols and then on the Symbol menu button — or use the short-
cut key [F8].

 2) In the Symbol menu: Find the symbol you wish to save as a DWG/DXF file, 
click on it and click on Edit symbol.

 3) In the Symbol editor: Choose File => Save as.

 4) In the dialog box Symbol settings: Click OK.

 5) In the dialog box Save as: Set the filetype to DWG files (*.dwg) or DXF files 
(*.dxf), type in a file name, and click Save.

 6) In the dialog box Open mapfile: Choose the mapfile and click Open.

 7) In the Symbol editor: Choose File => Close — to leave the Symbol editor.

Option Consequence

1 page pr. 
file

Each page in the project is exported as a separate file.

1 page pr. 
layer. One 
file only

Each page in the project is saved on a separate layer. This way 
you can save all of the project in the same file.
If the Automation project contains layers, the division in layers 
no longer exists.

Only page 1 Only the active page in the project is exported.

Page 1. 
Layer: 
Layer 1

Only the selected layer on the active page in the project is 
exported.
The layer is selected at the bottom of the dialog box, where you 
get the option to choose between the layers on the page.

Layer 
(Layer 1) on 
page 1, 
exploded

When you choose this option, you choose which layer to explode, 
and then export.
Output can for instance be applied for a numerically controlled 
machine.

USING DWG/DXF map options FOR EXPORT

WHEN EXPORTING TO THE DWG/DXF FORMAT, YOU CAN ALSO USE THE 
TOOL DWG/DXF map options, AS DESCRIBED IN “THE WORK PROCESS 
WHEN CONVERTING DWG/DXF FILES” ON PAGE 16.
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 8) In the Symbol menu: Click Cancel to return to the project.

— Read more about how to edit and save symbols in "Creating Symbols" in the 
Automation manual.

Map settings for Export of DWG/DXF files

When you export from Automation to the DWG/DXF format, you do not have as 
many options available, as when importing DWG/DXF files in Automation.

Therefore you only have the first part of the tabs in the tool DWG/DXF map opti-
ons available:

— Read more about the options on the individual tabs in “DWG/DXF map options” 
on page 21.
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Symbol documentation

Auto
SYMBOL DOCUMENTATION

ON SYMBOL DOCUMENTATION

In Automation it is possible to create graphical 
symbol documentation automatically.

This can either be documentation of a symbol 
library, or documentation of the symbols used in a 
project.

You can print out a graphical survey of the sym-
bols, as well as a list of the symbols, ordered by 
their symbol title. — Please refer to page 56 for 
further details.

The documentation is created as an independent 
Automation project, and can be printed out as a 
such.

To create the symbol documentation, you start by 
choosing Tools => Symbol documentation.

THIS CHAPTER DESCRIBES

— ON SYMBOL DOCUMENTATION ...................................................................(P. 51)
— SETTINGS IN SYMBOL DOCUMENTATION .....................................................(P. 52)
— THE TAB SYMBOLS....................................................................................(P. 53)
— THE TAB TEXTS .........................................................................................(P. 54)
— THE TAB PAGES ........................................................................................(P. 56)
— THE TAB ADJUSTMENTS.............................................................................(P. 59)
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SETTINGS IN SYMBOL DOCUMENTATION

You now enter the dialog box Symbol documentation, which contains the follo-
wing four tabs:

The functions on the tabs is elaborated in the following.

Create the documentation

When you have specified the settings you want on the tabs, you click OK in the 
right hand side of the dialog box. Then a new project is created, containing the 
complete symbol documentation. The project containing the symbol documenta-
tion can now be printed as an ordinary Automation project.

Tab Function Page

Symbols Here you specify what you wish to document. (p. 53)

Texts Here you specify which texts you wish to display in the gra-
phical documentation.

(p. 54)

Pages Here you specify which drawing header you wish to apply on 
the graphical documentation, as well as which drawing hea-
der you wish to apply if you print out a list ordered by for 
instance symbol names.

(p. 56)

Adjustments Here you specify the guidelines for the location of the sym-
bols in the documentation, as well as the number of symbols 
on each documentation page.

(p. 59)
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SYMBOLS

When you wish to create a graphical survey, you specify which symbols you wish to 
document on the tab Symbols.

Specify what you wish to document

If you have opened a project and wish to document the symbols in this project, 
click on Symbols in current project.

If you wish to document an entire symbol library, click on Symbols in symbol 
library, and then click your way to the desired library.

Other settings

If you only wish to print out symbols, which have been created/changed after a cer-
tain date, you can enable Only include symbols modified after on the lower part 
of the tab, and specify the date in the date field.

Choose library
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TEXTS

On the tab Texts you specify which texts you wish to include into the documenta-
tion.

Project title in the symbol documentation

In the text field Project title you specify the contents of the data field Project data 
=> Title in the documentation project. The text in this data field is inserted in the 
drawing headers on each page in the documentation project.

You can type in a text yourself, as well as insert information from the Insert data 
field list.

From Insert datafield you can 
choose the data fields mentioned in 
the table below. You can either dou-
ble-click on a data field, or drag it to 
the Project title text field.

When you double-click on the one of the data fields, it is inserted where the cursor 
last was placed in the Project title text field. Remember to place a [space] sign 
when necessary.

When you let the mouse pointer rest on the Project title field, a hint is displayed, 
showing how the title will be printed in the final symbol documentation project.

Data field States Displayed as

Symbol library The name of the symbol library. [SYMBOLLIBRARY]

Symbol library w/
full path

The name of the symbol library, and the 
full path leading to the library.

[SYMBOLLIBRARY-
PATH]
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The texts for the individual symbols

Under each symbol in the graphical 
survey, the name and the title of the 
symbol is displayed.

Furthermore, you can specify which 
other texts shall be placed below the 
individual symbols in the graphical survey.

Empty texts

If there are empty texts in the symbol 
definitions, and you would like to see 
how the texts are placed, you can fill 
in sample texts in the text fields Insert 
text in empty symbol name texts and Insert text in empty connection point 
name texts.

For instance you could type in NAME in the text field for the symbol name texts, 
and NNNN in the text field for the connection point names.

Symbols last 
modified date

The date specified under Only include 
symbols modified after on the tab 
Symbols.

[SYMBOLSMODI-
FIEDDATE]

Project title The name from the Project title field in 
the dialog box Settings => Project data.

[PROJECTTITLE]

Project file name The name of the project file. [PROJECTFI-
LENAME]

Project full path The path leading to the project file, as 
well as the name of the project file.

[PROJECTFULLPATH]

Current date The current date. [DATE]

Enable Signifies

Include file path in symbol name The entire path is specified for each symbol file 
name.

Never break words in symbol 
name or -title

Neither the words in the symbol file name nor the 
title (description) must be hyphenated.

Force visibility of symbol texts Symbol texts, which are invisible in the symbol defi-
nitions, will be visible in the documentation. If this 
option is disabled, only symbol texts, which are set 
to be visible in the symbol definition, will be printed.

Force visibility of connection point 
texts

Connection point texts, which are invisible in the 
symbol definitions, will be displayed in the docu-
mentation. If this option is disabled, only connec-
tion point texts, which are set to be visible in the 
symbol definition, will be printed.

Data field States Displayed as
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PAGES

When you wish to specify which drawing headers you wish to apply in the symbol 
documentation, you click on the Pages tab. You then enter this dialog box:

Graphical symbol survey

In the field Drawing header — under Graphical symbol survey — you choose 
which drawing header you wish to apply when you create the graphical part of the 
documentation.

The following drawing headers for symbol documentation can be found in the sym-
bol library misc, and on the list of drawing headers in Automation:

You can apply one of these drawing headers, or a drawing header you have desig-
ned yourself. When you click on the down-arrow in the Drawing header field, you 
get the list of drawing headers in Automation.

Drawing header Use

A3SYMDOC A3 drawing header for documentation of symbols (On A4 paper). 
The symbols are listed in the documentation sorted by symbol 
file names.

A4SYMDOC A4 drawing header for documentation of symbols. The symbols 
are listed in the documentation sorted by symbol file names.

A4SYMDOL A4 drawing header for documentation of symbols. The symbols 
are listed in the documentation sorted by symbol titles.

Click here for a list of drawing headers
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— If you type in the name of the drawing header — opposed to clicking on the 
name of a drawing header — you have to type in the entire path leading to the dra-
wing header.

User designed drawing headers

If you have designed your own drawing header for symbol documentation purpo-
ses, you have to insert the drawing header on the list of drawing headers.

This is done by choosing Settings => Text/Symbol defaults, clicking on Drawing 
headers, and then on Add. This brings you into the Symbol menu, where you 
click on the required drawing header, and then click OK.

You will not be able to choose the drawing header from SymDoc until you have 
done so.

— Please refer to the Automation manual for further details about this, and about 
how to create drawing headers.

Drawing headers for symbol lists

If you also want a list of the symbols, you enable Create symbol list in the Sym-
bol list part of the tab. This list can for instance be arranged according to the sym-
bol names, and contain references to the locations of the symbols in the graphical 
survey.

In the field under Drawing header, you can then specify which drawing header you 
wish to apply when you create the list.

Clicking on the down-arrow in the Drawing header field, gives you the list of dra-
wing headers for symbol lists. If the required drawing header is not on the list of 
symbol list drawing headers, you right-click on the field, and get the following opti-
ons:

Here you click on Add symbol-list drawing header, and enter the list of drawing 
headers in Automation.

Click on the desired drawing header, and then on OK.

By clicking on Remove symbol-list drawing header you can accordingly remove 
drawing headers from the list of drawing headers for symbol lists.
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Creating your own drawing headers

Please refer to the Automation manual to see how to design your own drawing 
headers / lists, as well as to see how to insert these on the list of drawing headers 
in Automation. — If you wish to design your own drawing headers for symbol 
documentation and lists, it is recommended to edit the existing drawing headers. 
This is because the datafields are used in a special way in these drawing headers.

Create the documentation

When you have specified all the settings, you click OK to create the symbol docu-
mentation, as described in “Create the documentation” on page 52.
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ADJUSTMENTS

When you wish to specify the space between the symbols on the page, you click 
on the Adjustments tab:

Here you can specify the following settings, which are all illustrated on the figure on 
the tab.

Minimum space between symbols

In the fields Horizontal (a) and Vertical (b) the space between 
the symbols are specified. — Please note, that the figure dis-
plays how much room the symbols and their texts take up.

Minimum space form page margin to symbol

In the fields Horizontal (c) and Vertical (d) the page margins are specified. The 
horizontal goes for the left- as well as the right margin on the page, while the verti-
cal specifies the top- and bottom margin.

Minimum width of symbol texts (e)

When the program calculates how much room is nee-
ded for the symbols on the page, it starts off conside-
ring the size of the symbols. If the symbols are 
relatively small, not much room will be left for the sym-
bol texts. It is therefore a good idea to specify how 
much space the symbol texts needs as a minimum. 
For the displayed symbol, the text would for instance 
be hyphenated over several lines, if only the width of 
the symbol should determine the width of the text.
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Scale symbols in the documentation project

If you wish to downscale the largest symbols in the documentation, you have two 
different options at hand:

If you enable Scale symbols too large to place on page, you downscale sym-
bols, which are too large to be placed on a documentation page in scale 1:1.

If you enable Scale symbols larger than the average size of the symbols, you 
downscale symbols, which are larger than the average size of the symbols in the 
entire documentation project.

When necessary, the symbols will be downscaled to either 1:2, 1:4 or 1:8. If a sym-
bol have been downscaled, this will be mentioned after the filename in the docu-
mentation.

Symbol text above the symbol

If you enable Place symbol filename and -title ABOVE the symbol, the symbol 
filename and the symbol title will be placed above the symbols in the documenta-
tion. If the function is disabled, these texts will be placed below the symbols.

Maximum number of symbols per page

On the lower part of the tab, you can specify maximum number of symbols you 
wish to place on a symbol documentation page.

The size of the symbols, as well as the settings you have specified on the upper 
part of the tab, puts a natural limit for how many symbols can be placed on the 
page.

Therefore it only makes sense to fill out this field if you want less symbols placed 
on a page, than the program would suggest.
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GRAPHICAL TERMINAL PLANS

In Automation you can create graphical terminal plans for your projects.

ON GRAPHICAL TERMINAL PLANS

The graphical terminal plan for a project can either be 
created as an independent Automation project, or be 
inserted in the active project.

When the terminal plan is created, you can edit it by 
moving lines and symbols, as on any diagram page. If 
you, at a later stage, need an updated version of the ter-
minal plan, you can transfer the changes you have 
made in the terminal plan to the new terminal plan auto-
matically.

— When a terminal plan does not turn out the way you 
expected it to, you can always change the terminal plan 
settings, and create new terminal plan.

Graphical terminal plans can be printed just like you nor-
mally print pages in Automation projects.

THIS CHAPTER DESCRIBES

— ON GRAPHICAL TERMINAL PLANS................................................................(P. 63)
— CREATING GRAPHICAL TERMINAL PLANS .....................................................(P. 64)
— THE STRUCTURE OF GRAPHICAL TERMINAL PLANS ......................................(P. 65)
— SETTINGS IN CREATE GRAPHICAL TERMINAL PLAN ......................................(P. 66)
— THE TAB CONNECTIONS ............................................................................(P. 67)
— THE TAB PAGES ........................................................................................(P. 69)
— THE TAB SYMBOLS....................................................................................(P. 71)
— THE TAB WIRES ........................................................................................(P. 76)
— THE TAB ADJUSTMENTS.............................................................................(P. 77)
— ADJUSTMENTS FOR TERMINAL PLANS ACCORDING TO CABLES .....................(P. 79)
— UPDATING EXISTING GRAPHICAL TERMINAL PLANS.......................................(P. 80)
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CREATING GRAPHICAL TERMINAL PLANS

To create a graphical terminal plan for a project, open the project, and choose 
Tools => Graphical terminal plan in Automation. You then enter the dialog box 
Create graphical terminal plan.

If you have already created a graphical terminal plan, and have inserted it in the 
active project, you will enter the dialog box Update graphical terminal plan, as 
described in “Updating existing terminal plans” on page 80.

When the terminal plan is created, you will be asked whether you wish to insert it in 
the project — if you have not inserted it already:

Answering Yes - to inserting the terminal plan in the project

If you answer Yes, the terminal plan is inserted in the project, along with a divider 
page with the title TermPlan. When you make manual changes in this terminal 
plan, these can be included when you generate a new terminal plan.

The pages in the terminal plan are assigned the page type TEP. In Automation 
projects they therefore get no effect on the electrical and mechanical lists in the 
project.

When you edit the diagram pages in the Automation project, the terminal plan is 
not updated automatically. To get an updated version of the terminal plan, you must 
therefore choose Tools => Graphical terminal plan again — as described in 
“Updating existing terminal plans” on page 80.

Answering No - to inserting the terminal plan in the project

If you answer No in the dialog box, the terminal plan is created as an independent 
Automation project with the name Termplan. If you later make changes in the ori-
ginal project, and therefore wish to generate a new terminal plan, you will not have 
the option to include manually performed changes, from the old terminal plan, in 
the new terminal plan. This will not be possible until you copy the terminal plan into 
the original Automation project.
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THE STRUCTURE OF THE TERMINAL PLAN

The graphical terminal plan can be created in two ways:

a) the direct connection between terminals and symbols is displayed (A)

b) structured according to which cables the terminals are connected to (B)

These two ways are illustrated below:

You find the buttons A and B in the right-hand side of the dialog box.

A

B
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SETTINGS IN CREATE GRAPHICAL TERMINAL PLAN

The dialog box Create graphical terminal plan contains the following tabs:

The functions on these tabs are described in the following.

Create the graphical terminal plan

When you have specified the settings on the tabs, you click OK in 
the right-hand side of the dialog box. Then a new Automation 
project is created, containing the graphical terminal plan for the 
terminal rows you have chosen to document.

When you click on Cancel, you exit the dialog box, and no cable 
plan is created.

When you click on Reset, the settings in the dialog box are set to the program 
default settings.

Tab Function Page

Connections Here you specify which connections you wish to docu-
ment, how they are going to be placed, as well as which 
terminal rows you wish to document.

(p. 67)

Pages Here you choose a drawing header, type in a caption for 
the connections, and specify whether to have page 
breaks between the terminal rows.

(p. 69)

Symbols Here you choose which terminal symbol to apply, which 
symbol texts to include into the documentation, as well as 
whether to allow to rotate the symbols in the documenta-
tion.

(p. 71)

Wires Here you specify if you want cable information or wire 
numbers on the cable wires in the documentation.

(p. 76)

Adjustments Here you specify the minimum distance between termi-
nals and symbols, and of the connection heading.

(p. 77)
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CONNECTIONS

On this tab you for instance specify which connections you wish to document, how 
they are going to be placed, and which terminal rows you wish to include in the 
documentation.

External and/or internal connections

In the upper left-hand corner of the tab, you 
choose whether to document the internal and/or 
the external connections of the terminals in the 
project.

Orientation

In the upper right-hand corner of the tab, you 
specify whether to arrange the terminal rows 
Left to right or Top to bottom.

To choose which drawing header — and with 
that which paper size — you wish to use in the 
documentation, please refer to “Drawing header” on page 69.

Placing external/internal connections

Under Place connected symbols you specify 
how you want the external and internal connec-
tions to be placed. The options depends on 
which connections you have chosen to docu-
ment.

Selecting terminal rows

If you do not specify otherwise, the program presumes that you wish to document 
all terminal rows in the project. However, if this is not the case, click Select/
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Deselect in the lower right-hand corner of the dialog box. You then enter this dialog 
box:

If you wish to deselect a terminal row, first click on the terminal row in the column to 
the right, and then on the left-arrow in the dialog box.

If you wish to include the terminal row anyway, select it in the left-hand side of the 
dialog box, and click the right-arrow.

By clicking on the double left-arrow and the double right-arrow, you transfer all ter-
minal rows back and forth between the columns.

Sorting the terminal rows

For a start, the terminal rows are sorted according to the common guidelines in 
Automation — see the manual for Automation.

When you want the terminal rows to appear in another order, you can click on them 
and drag them to the desired position.

If you again want the terminal rows in sorted order in the generated terminal plan, 
click on Sorted at the bottom of the screen. When the terminal rows appears in 
sorted order, the button will be pressed in.

In the generated terminal plan, the terminal rows in the first column are docu-
mented first — starting with the uppermost terminal row in the column. Then the 
second column is documented, and so on.
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PAGES

On the Pages tab you for instance choose which terminal header you wish to use 
in the documentation project, type in a caption for the project connections, and 
specify whether to insert page breaks between the terminal rows.

Drawing header

In the field Drawing header you specify which drawing header to use in the graphi-
cal terminal plan.

When you click on the down-arrow in the Drawing header field, you get the list of 
drawing headers in Automation, and click on the drawing header you wish to 
apply. You can only apply drawing headers which have been placed on this list.

User defined drawing headers

If you have designed your own drawing header for graphical terminal plans, you 
must insert it on the list of drawing headers in Automation.

You will not be able to choose the drawing header on the Pages tab until you have 
done so.

— Please refer to the Automation manual for further details about this, and for 
information about how to design your own drawing headers.

DRAWING HEADERS WHEN UPDATING TERMINAL PLANS

IF YOU DO NOT GET THE OPTION TO SELECT A DRAWING HEADER, THIS IS 
BECAUSE A DRAWING HEADER IS ALREADY PLACED ON THE CREATED TERMI-
NAL PLAN PAGES IN THE PROJECT.
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Caption
In the fields External connec-
tion and Internal connection 
you specify the caption for the 
external- and internal connec-
tions respectively in the graphi-
cal terminal plans.

The program automatically 
remembers the captions you 
have applied on previous termi-
nal plans.

Clicking on the down-arrows in the caption fields, gives you the option of choosing 
between these.

Placing methods

When you specify according to which principle the terminals shall be placed in the 
terminal plan, you have two options:

Fixed space between terminals

If you enable Fixed space between 
terminals, the terminals are placed at 
fixed intervals.

— Please refer to “Minimum space 
between terminals” on page 77, to 
see how to specify the lower limits for the distance between the terminals.

Minimize number of line breaks

When the terminals are placed side by side, this results in more line breaks, than if 
it is allowed to move the terminals in order to get straight lines. This happens when 
you choose Minimize number of line breaks.

Page break between terminal rows

When you want only one terminal row on each page, select Page break between 
terminal rows on the lower part of the tab.
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SYMBOLS

Here you for instance determine which terminal symbol to use in the graphical ter-
minal plan, which symbol texts to include, and whether to allow the symbols to be 
rotated.

Include symbol texts

On the upper part of the tab, 
you specify which symbol 
texts you wish to include on 
the graphical terminal plans.

When you select As in pro-
ject, the texts, which are dis-
played in the project, are also 
displayed in the terminal plan.

When you do not choose As 
in project, you can click on 
the + sign for Terminals, 
Cables and Other symbols. 
You can then select which of 
the texts to display in the ter-
minal plan.

When the space between symbols and terminals is calculated in the terminal plan, 
the chosen texts are also taken into consideration. This can lead to room for less 
symbols on each page in the graphical terminal plan.

Click here

Drag here
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Allow rotation

If you do not mind that the connected symbols are rotated on the terminal plan, you 
can enable Allow rotation. This can make it easier for the program to draw the 
lines on the terminal plan, which makes the terminal plan more clear.

Allow scaling

When you choose Allow scaling, you allow the program to downscale the symbol 
sin the terminal plan, so that there can be more symbols on each page.

The symbols are only downscaled so that the connection points does not get pla-
ced to close to be readable.

Allow changing symboltext positions

When you do not choose Allow changing symboltext positions, the symbol texts 
for each individual symbol are placed exactly as they are placed in the diagram 
pages.

Because this is not always the perfect solution in graphical terminal plans, it is 
recommended to let the program handle the placing of the symbol texts in terminal 
plans.

When this option is not selected, it will typically be necessary to use symbol substi-
tution to avoid spending too much time editing the terminal plan after it is gene-
rated. — See “Symbol substitutions” on page 74.

Terminal symbol

At the bottom of the dialog box, you choose which terminal symbol to apply on the 
terminal plan. When you click on the down-arrow, you can choose between the 
previously used symbols.

Without rotation With rotation
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The terminal symbols, you can choose between right away, look like this:

These symbols are only examples of what you might want to use for representation 
of the terminals in the terminal plan.

If you wish to use another terminal symbol, you can type in the name of the symbol 
in the field.

Terminal symbol for displaying jumpering links

To display jumpering links in ter-
minal plans, the symbol must 
have extra connection points. 
These must have IO status 
Main type set to None — as 
displayed in the figure to the 
right.

Read more about designing 
symbols in the Automation 
manual.

The symbol P_TERM.SYM can be applied for displaying jumpering links in the ter-
minal plan.

Jumpering links are displayed in the terminal plan as straight lines between the 
connection points in the terminal symbols.

Path leading to the terminal symbol

The filename of the terminal symbol can be typed in with or without a path specify-
ing in which folder the symbol is placed.

If you type in the entire path leading to the terminal symbol, the program will always 
be able to locate the symbol.

As you can see above, only the symbol filename is specified in the Terminal sym-
bol field. This is possible because the symbols are located in a library, which has 
an alias assigned to it in the Alias for libraries dialog box in Automation.

You enter this dialog box by first choosing Settings => Libraries, then click on 
Symbols, and on Display library alias.

— You can read more about alias in the Automation manual.

Applied for jumpering links
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Symbol substitutions

When you click on the button Symbol substitution, a dialog box is opened, which 
is used for identifying which project symbols, that shall be substituted by which 
symbols in the graphical terminal plan.

For instance you can choose to represent selected symbols — or all symbols — by 
simple boxes.

To specify that one symbol shall be used as a substitution for another, click on 
Select:

Type in the filename for the symbol you wish to use in the terminal plan, and click 
OK.

Then type in which symbols on the diagram pages, that shall be substituted by the 
selected symbol.

This can be done in two ways:

a) Specifying Lettercode(s): Here you can for instance specify that all symbols 
having the lettercode -M shall be replaced by the selected symbol

b) Specifying Filename(s): Here you can for instance specify that all symbols 
having the filename 06-08-01 shall be replaced by the selected symbol

When there are more project symbols that shall be substituted by the same sym-
bol, this is specified by separating their filenames or lettercodes with a comma — 
as for instance 06-08-01,06-08-05 in the figure above.

To delete a line in the dialog box, click on the line, and then click Delete.

Click OK to leave the dialog box.

THE SUBSTITUTION SYMBOLS MUST HAVE AT LEAST THE SAME AMOUNT OF 
CONNECTION POINTS, AS THE SYMBOLS THEY REPLACE.
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Designing your own terminal symbols

You can also design a terminal symbol which matches the settings you have cho-
sen for the terminal plan. How to do this is described in the Automation manual.

Please note that the standard terminal symbol 03-02-03 only has room for two 
digits for a connection name inside the box. This will make the program increase 
the distance between the terminals when the connection name is included/visible.
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WIRES

On the Wires tab you for instance specify which information to attach to the cable 
wires on the internal and external side of the terminal.

You can here choose between the following options:

This can be done at the external and the internal side of the terminal.

Option Function

None Places no information

Cable Places a cable symbol

Wire number Places a wire number
Automation Tools

age 76



Graphical Terminal Plans

Auto
ADJUSTMENTS

On the Adjustments tab you for instance specify the smallest allowed interval bet-
ween terminals and symbols, and the size of the caption for the connections.

The contents of this tab depends on whether you have chosen to display the direct 
connection between terminals and symbols, or you have chosen to structure the 
terminal plan according to the used cables. — Please refer to “The structure of the 
terminal plan” on page 65 for further details.

The appearance described here is for the direct connection. 

Margins

At the top of the tab you specify the left and right margin (l), the top 
margin (m) and the bottom margin (n) on the project pages.

Please note that these margins specifies the distance to the frame of 
the drawing header used on the pages.

Minimum space between terminals

In the field Minimum space between ter-
minals you specify the smallest allowed 
distance between the terminals in the gra-
phical terminal plan. The distance is measu-
red from the border of the one terminal to 
the border of the other. However, the termi-
nals cannot be located so close, that the 
texts overlap. When you set the space to 0, 
the terminals will be placed as close as pos-
sible. Space between terminals
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Minimum space between symbols

In the field Minimum space between 
symbols you specify the smallest 
allowed distance between the sym-
bols in the terminal plan. Here the 
symbol texts are included in the calcu-
lations, and the distance is measured 
from the outline of the one symbol 
(including its texts) to the outline of 
the other.

Font height of the caption

In the field Connection caption font 
height you specify the font size of the 
captions for the external and internal 
connections.

Dashed lines on external side

If you select Dashed lines on external side, the lines on the external side of the 
terminal symbols will be drawn using a dashed linestyle.

Space between symbols
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ADJUSTMENTS FOR TERMINAL PLANS STRUCTURED ACCORDING TO 
CABLES

When you have chosen to structure the terminal plan according to the used cables 
— please refer to “The structure of the terminal plan” on page 65 — the Adjust-
ments tab looks like this:

Lines indicating cables

The major difference here is that you now 
have to specify the width of two types of 
lines:

- the line representing the cable (the 
"horizontal" line), and

- the appearance of the line used for indi-
cating which cable wires are included 
in the cable (the "vertical" line)

The terms "horizontal" and "vertical" refers 
to the figure at the upper-right corner of 
the tab.

Creating the graphical terminal plan

When you have specified the settings on the tabs, click OK in the right-hand side of 
the dialog box to create the graphical terminal plan, as described in “Create the 
graphical terminal plan” on page 66.

Click here

The "horizontal" line

The "vertical" line
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UPDATING EXISTING TERMINAL PLANS

When you have already created a graphical terminal plan for the active project, and 
choose Tools => Graphical Terminal Plan, you enter the dialog box Update 
graphical terminal plan:

Here you have two options:

a) Rebuild entire terminal plan which is described in “Rebuild entire terminal 
plan” on page 80: Choose this option when you have not made changes in 
the existing terminal plan, that you wish to keep

b) Update terminal plan, changes only which is described in “Update terminal 
plan, changes only” on page 81: Choose this option when you have made 
changes in the existing terminal plan, that you do wish to keep

Rebuild entire terminal plan

When you choose Rebuild entire terminal plan, the terminal plan is created from 
scratch.

Rebuilding the terminal plan with Use settings from last update

When you select Use settings from last update in the lower-left corner of the dia-
log box (hereby meaning the applied settings for connections, symbols, wires and 
adjustments), you enter this dialog box:

When you need to change which terminal rows to include in the terminal plan, click 
on Select/Deselect. Then select the terminal rows as described in “Selecting ter-
minal rows” on page 67.
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When you need to change the order of appearance of the documented terminal 
rows, this is done as described in “Sorting the terminal rows” on page 68.

When you then click on Update, the terminal plan is updated without entering the 
settings dialog box.

Rebuilding the terminal plan Without Use settings from last update

When you do not select Use settings from last update in the lower-left corner of 
the dialog box, you jump right to the update dialog box — as described in the start 
of this chapter — when you click on Update.

Update terminal plan, changes only

When you wish to keep the existing terminal plan — or parts of the existing termi-
nal plan — choose Update terminal plan, changes only and click on Next:

Specifying which terminal plans to update, add or delete

You now enter this dialog box, in which you specify exactly which parts of the termi-
nal plan to update, and which to keep exactly as they are now — including your 
possible changes:

DELETING A TERMINAL ROW FROM THE EXISTING TERMINAL PLAN

WHEN YOU WISH TO DELETE A TERMINAL ROW, WHICH EXISTS IN THE CUR-
RENT TERMINAL PLAN, SELECT THE TERMINAL ROW IN THIS DIALOG BOX. IN 
THE FOLLOWING DIALOG BOX YOU CAN THEN HAVE IT DELETED.
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As a starting point, you get a status for the individual terminal rows, which you can 
change according to your needs:

The selected terminal rows will be updated.

The program always updates full pages in the terminal plan.

Updating already documented terminal rows

You can select a terminal row, which have already been documented in the present 
terminal plan. Hereby all of the page, on which the terminal plan is placed, are 
updated in the terminal plan.

If there is another terminal plan on this page in the existing terminal plan, this other 
terminal row will therefore also be updated. This is displayed by an automatically 
set check mark for this terminal row in the survey, when you select the first terminal 
row.

Deselecting new terminal rows

You can also remove the check mark from one of the new terminal rows, and the 
terminal row will not be documented in the terminal plan.

Updates all succeeding pages in the terminal plan

When the program updates one page in the terminal plan, all succeeding pages in 
the terminal plan are updated also.

SPECIFYING CHANGES IN THE EXISTING TERMINAL PLAN

THE PROGRAM AUTOMATICALLY DETECTS WHETHER THERE HAVE BEEN 
ADDED TERMINAL ROWS TO THE DIAGRAMS SINCE THE LAST UPDATE.
WHEN OTHER CHANGES HAVE BEEN MADE IN THE DIAGRAMS, YOU MUST 
SPECIFY THIS BY SELECTING THE CHANGED TERMINAL ROWS.

Terminal rows
with created
terminal plan

New
terminal rows

Click here to
update the
terminal row

Click here
not to create
terminal plan
for this row
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Status at the bottom of the dialog box

At the bottom of the dialog box you see a total status of which pages remains 
unchanged, which existing pages are updated, and whether new pages are added 
to the terminal plan.

Click on Next.

Specifying order of appearance for new and updated terminal rows

You now enter this dialog box, where you can specify the order of appearance for 
the new and for the updated terminal rows in the terminal plan:

When you wish to delete terminal rows from the terminal plan, click on Select/
Deselect. Read more about this in “Selecting terminal rows” on page 67.

When you wish to change the order of appearance of the documented terminal 
rows, this is done as described in “Sorting the terminal rows” on page 68.

Click on Update and the terminal plan is updated.

WHEN YOU ONLY HAVE ADDED TERMINAL ROWS

WHEN YOU KNOW THAT YOU ONLY HAVE ADDED NEW TERMINAL ROWS, DO 
NOT MAKE CHANGES IN THE DIALOG BOX. IN THIS CASE, THE PROGRAM WILL 
AUTOMATICALLY KEEP THE ORIGINAL TERMINAL PLAN PAGES AS THEY ARE, 
AND ADD THE NECESSARY PAGES TO THE TERMINAL PLAN.
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GRAPHICAL CABLE PLANS

In Automation you can also create graphical cable plans for your projects.

ON GRAPHICAL CABLE PLANS

The graphical cable plan for a project can be created as an indepen-
dent Automation project, or can be inserted directly in the active 
project.

When the cable plan is created, you can edit the created cable plan 
by moving lines and symbols, as on normal diagram pages. If you, at 
a later stage, need to let the program update the cable plan, you can 
transfer the changes you have made in the cable plan to the new 
cable plan.

— If a cable plan does not turn out as you want it to, you can always 
change the cable plan settings, and create a new cable plan.

You can print graphical cable plans as you normally print projects in 
Automation.

CREATING GRAPHICAL CABLE PLANS

To create a graphical cable plan for a project, open the project, and 
choose Tools => Graphical Cable Plan in Automation. You then 
enter the dialog box Create graphical cable plan.

If you have already created a graphical cable plan and inserted it in 
the active project, you enter the dialog box Update graphical termi-
nal plan, as described in “Updating existing graphical cable plans” 
on page 94.

When the cable plan is created, you will be asked whether you wish 
to insert it in the project — if you have not already inserted a cable plan.

This is done just like for graphical terminal plans. Read more about the consequen-
ces of answering Yes or No in “Answering Yes - to inserting the terminal plan in the 
project” on page 64 and “Answering No - to inserting the terminal plan in the pro-
ject” on page 64 respectively.

THIS CHAPTER DESCRIBES

— ON GRAPHICAL CABLE PLANS.....................................................................(P. 87)
— CREATING GRAPHICAL CABLE PLANS ..........................................................(P. 87)
— SETTINGS IN CREATE GRAPHICAL CABLE PLAN............................................(P. 88)
— THE TAB CONNECTIONS ............................................................................(P. 89)
— THE TAB PAGES ........................................................................................(P. 90)
— THE TAB SYMBOLS....................................................................................(P. 91)
— THE TAB ADJUSTMENTS.............................................................................(P. 93)
— UPDATING EXISTING GRAPHICAL CABLE PLANS ............................................(P. 94)
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The pages in the cable plan gets the page type CAP. In Automation projects their 
contents are not added to the electrical and mechanical lists.

SETTINGS IN CREATE GRAPHICAL CABLE PLAN

The dialog box Create graphical cable plan contains the following tabs:

The functions on these tabs are described in the following.

Create the graphical cable plan

When you have specified the settings on the tabs, click OK in the 
right-hand side of the dialog box. Then a new graphical cable plan 
is created for the cables you have chosen to document.

When you click on Cancel, you exit the dialog box, and no cable 
plan is created.

When you click on Reset, the settings in the dialog box are set to 
the program default settings.

Tab Function Page

Connections Here you specify which connections you wish to document, 
how they are going to be placed, as well as which cables 
you wish to document.

(p. 89)

Pages Here you choose a drawing header, and specify whether to 
have page breaks between the cables.

(p. 90)

Symbols Here you choose which terminal symbol to apply, which 
symbol texts to include into the documentation, as well as 
whether to allow to rotate the symbols in the documentation.

(p. 91)

Adjustments Here you specify the cosmetic setup of the cable plan. (p. 93)
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CONNECTIONS

On this tab you for instance specify which connections you wish to document, how 
they are going to be placed, and which cables you wish to include in the documen-
tation.

External and/or internal connections

In the upper left-hand corner of the tab, you 
choose whether to document the Cables 
FROM end and/or the Cables TO end.

Orientation

In the upper right-hand corner of the tab, you spe-
cify whether to arrange the symbol row Left to 
right or Top to bottom.

To choose which drawing header — and with that a 
paper size — you wish to apply in the documentation, please refer to “Drawing 
header” on page 90.

Cable direction

Under Cable direction you specify the cable direction in the 
cable plan. The options depends on the chosen orientation of 
the symbol row.

Selecting cables

Choose which cables to document as described in “Selecting terminal rows” on 
page 67.

Sorting cables

Specify the sorting order of the cables as described in “Sorting the terminal rows” 
on page 68.
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PAGES

On the Pages tab you choose which drawing header you wish to use in the cable 
plan, and specify whether to insert a page break between the cables.

Drawing header

In the field Drawing header you determine which drawing header to use in the gra-
phical cable plan.

When you click on the down-arrow in the Drawing header field, you get the list of 
drawing headers in Automation. Click on the drawing header you wish to use. You 
can only use drawing headers which have been placed on this list in Automation.

User defined drawing headers

Please refer to “User defined drawing headers” on page 69 for further details about 
designing your own drawing headers for cable plans.

Page break between cables

When you only want one cable on each page, select Page break between cables 
on the lower part of the tab.

DRAWING HEADERS WHEN UPDATING CABLE PLANS

IF YOU DO NOT GET THE OPTION TO SELECT A DRAWING HEADER, THIS IS 
BECAUSE A DRAWING HEADER IS ALREADY PLACED ON THE CREATED CABLE 
PLAN PAGES IN THE PROJECT.
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SYMBOLS

Here you for instance determine which terminal symbol to apply in the graphical 
cable plan, which symbol texts to include, and whether to allow the symbols to be 
rotated.

Include symbol texts

On the upper part of the tab, you specify which symbol texts you wish to include on 
the graphical cable plans.

Read more about this in “Include symbol texts” on page 71.

Allow rotation

If you do not mind that the connected symbols are rotated on the cable plan, you 
can enable Allow rotation. Please refer to “Allow rotation” on page 72 for further 
details.

Allow scaling

Read about this in “Allow scaling” on page 72.

Allow changing symboltext positions

Read about this in “Allow changing symboltext positions” on page 72.
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Terminal symbol

Please refer to “Terminal symbol” on page 72 for further details about choosing ter-
minal symbols for the cable plan.

Symbol substitutions

Read about this in “Symbol substitutions” on page 74.
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ADJUSTMENTS

On the Adjustments tab you specify the cosmetic aspects of the cable plan.

Margins

At the top of the tab you specify the left margin (l), the top margin 
(m) and the bottom margin (n) on the project pages.

Please note that these margins are the margins between the sym-
bols on the cable plan and the frame of the used drawing header.

Distance from cable symbol to
cable line

The Space from symbol to cable line 
specifies the distance from the "vertical 
line" to the connected symbol — see the 
figure to the right.

Please refer to “Lines indicating cables” on 
page 79 for further details about the "verti-
cal" line.

Minimum space between sym-
bols

In the field Minimum space between 
symbols you specify the smallest allowed 
distance between the symbols in the cable plan. Please refer to “Minimum space 
between symbols” on page 78 for further details.

Distance from symbol
to cable line
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Space between cables

The Space between cables field sets the distance between the groups of symbols 
(including their texts) connected to the various cables.

Show wire numbers on cable wires

Select Show wire numbers on cable wires to have wire numbers placed on cable 
wires.

Lines indicating cables

Please refer to “Lines indicating cables” on page 79 for further details.

UPDATING EXISTING GRAPHICAL CABLE PLANS

When you have already created a graphical cable plan for the active project, and 
choose Tools => Graphical cable plan, you enter the dialog box Update graphi-
cal cable plan.

This takes place exactly as described for graphical terminal plans. Read more 
about this in “Updating existing terminal plans” on page 80.
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This — and the other options in the tool — is 
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PC|SCHEMATIC TEXT TRANSLATOR

PC|SCHEMATIC Text Translator is created for translating texts from one lan-
guage to another — for instance from English to German.

The program can also be used for checking e.g. an English project for spelling 
errors, and for checking whether project texts follow the company standard guideli-
nes for texts in projects.

TRANSLATING PROJECTS

To translate a project in Automation, you must first open the project. Then start 
PC|SCHEMATIC Text Translator by choosing Tools => Text translator, or by 
clicking the Text translator button in the program toolbar at the top of the screen.

You then enter the dialog box Text translator:

THIS CHAPTER DESCRIBES

— TRANSLATING A PROJECT...........................................................................(P. 97)
— THE TRANSLATIONS DIALOG BOX ..............................................................(P. 100)
— EDITING DICTIONARIES ............................................................................(P. 105)
— TRANSLATION OPTIONS ...........................................................................(P. 107)
— EDITING TOOL FOR TRANSLATIONS ...........................................................(P. 111)
— RECOGNITION AND TRANSLATION OF TEXTS..............................................(P. 112)
— TEXT POSITIONS IN PROJECTS FOR TRANSLATION......................................(P. 114)
— CONVERTING DICTIONARIES FROM THE PREVIOUS VERSION .......................(P. 115)
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Choose which languages to translate to and from

Here you choose which language to translate from, and which language to trans-
late to. If you select Show languages with existing dictionaries only, the list will 
only contain languages for which a dictionary exists.

Languages without dictionaries

When you choose two languages, for which no dictionary exists, you will get the 
option of creating a dictionary based on the translations you have created. — See 
“The Translations dialog box” on page 100, in particular “Creating the translated 
project” on page 104.

Changing options

If for instance you need to specify which project text types to translate, to change 
the settings for the available dictionaries, or to attach new dictionaries, click on 
Options. — Read more about this in “Options for the translation” on page 107.

Recognition and translation of texts

You can read more about how PC|SCHEMATIC Text Translator recognize texts in 
“Recognition and Translation of texts” on page 112.

Start translating the project

Now click on Translate, and the program starts translating the project.

Examination for Similar texts

What happens next, is that the program runs through all the project texts, in order 
to translate them. If there are texts in the project, which has no translation in the 

FOR USERS OF THE PREVIOUS VERSION

IF A DICTIONARY CREATED IN THE PREVIOUS VERSION OF PC|SCHEMATIC 
Text Translator EXISTS, YOU WILL BE ASKED WHETHER TO CONVERT THIS 
TO THE NEW FORMAT. READ MORE ABOUT THIS IN “CONVERTING DICTIONA-
RIES FROM THE PREVIOUS VERSION” ON PAGE 115.

PLACING TEXTS IN PROJECTS FOR TRANSLATION

IT IS A GOOD IDEA TO BE CAREFUL ABOUT HOW TO PLACE PROJECT TEXTS, 
WHEN YOU NEED TO TRANSLATE THE PROJECT TEXTS TO ANOTHER LAN-
GUAGE LATER.
— READ MORE ABOUT THIS IN “HOW TO PLACE TEXTS IN A PROJECT MEANT 
FOR TRANSLATION” ON PAGE 114.
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dictionary, and there exists a similar text in the dictionary, this similar text will be 
suggested to replace the text:

Here you can either choose to add the text to the dictionary (click Add to dictio-
nary), choose to continue without taking any action (click Ignore), or choose to 
click on Replace.

When you click on Replace, the text PCshematic ELautomation in the figure 
above is replaced with the text PCschematic ELautomation — in the original 
(here: English) project. This way, you can make sure that all texts are written con-
sequently throughout the project.

When you click on Ignore check, this check for similar texts is skipped, and 
PC|SCHEMATIC Text Translator continues the translation. When you click on 
Cancel, the translation is cancelled.

A status for the translation is now displayed:

Click OK. You now enter the dialog box Translations.

— Read more about the options you have here in “The Translations dialog box” on 
page 100.
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THE TRANSLATIONS DIALOG BOX

In the dialog box Translations, you can type in the missing translations, export the 
missing translations and import translations:

You have the following options:

Edit a text

You can edit a text in the Translations dialog box in two ways:

a) Activate the Edit text button, click on the text, and edit the text. Or:

b) Double-click on the text, and edit it.

Insert English text

If for instance you translate a project from 
English to Danish, you can transfer the Eng-
lish text unchanged to the column with the 
Danish translation. To do this, right-click in 
the column with the translation, and then 
choose Insert English text.

Please note, that you can also select multiple fields, and then choose Insert Eng-
lish text.

Double-click in a field to
enter a translation

Export the texts

Import the translated textsEdit texts
Find and Replace

Dictionary functions

Click, and see the position
of the text in the project

Create trans-
lated project
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Set to ’Not translated’ status

If you wish to assign the Not translated status 
to a text, right-click in the field with the text, and 
choose Set to ’Not translated’ status.

This means that the text — L3 in the figure 
above — is transferred unchanged to the translated project, and that the text will 
not appear in the list of texts in the Translations dialog box.

This status for the text is transferred to the 
original Automation project. In Automa-
tion, you can see this in the dialog box Text 
properties for the text, as displayed in the 
figure to the right.

Find and Replace

To search for a text, or a part of a text string, do this:

 1) Click in the column in the dialog box, which you wish to search for texts in:

 2) Click the Search button, and you enter the Find dialog box, where you spe-
cify what to search for, and click Find next:

If you in stead click the Replace button, you enter the Replace dialog box, where 
you have the following options:

In the Text properties dialog box
in PC|SCHEMATIC Automation

Click here to search
for English texts

Click here to search
for Danish texts
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Open the applied dictionary

To open the applied dictionary, click the Dictionary button.

This gives you the option of looking in the dictionary, while looking at the texts in 
the dialog box Translations. — Read more about this in “Editing Dictionaries” on 
page 105.

Translation using the dictionary

When you wish to translate the project texts using the dictionary, click the Trans-
late using dictionary button.

When you click this button, the texts are translated, just like what happened before 
you entered the Translations dialog box. You will therefore only need to click this 
button, if you previously chose to cancel the translation, or if you, or others, have 
updated the dictionary in the mean time. — Or if you have edited the texts in the 
original language.

Adding texts to the dictionary

When you have entered new translations in the Translations dialog box, you can 
transfer these to the dictionary by clicking the Add texts to dictionary button.

Export texts to translation

When you wish to send the texts to another person in order to have the texts trans-
lated, and this other person has no Automation license, do this:

 1) Click the Export to translation button.

 2) In the dialog box Save as: Specify where to save the file, and click Save:

 3) The exported file is now opened in the editing tool Edit exchange file. Here 
you can for instance edit texts and translations, and mail these to the person 
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that is going to translate the texts (read more in “Editing tool for exchange 
files” on page 111):

 4) In the dialog box Edit exchange file: Click the Send mail button, to mail a 
file containing texts and translations.

 5) Your e-mail program is now opened. Here you specify who to send the file to, 
and click Send:

When the receiver opens the attached file, he/she can open the file with the inde-
pendent program Edit exchange file (TXFedit.exe), which is used for the transla-
tion. This program/tool can be downloaded via DpS CAD-center’s website at 
www.pcschematic.com, or by clicking on the link to the program in the mail.

— Read more about this in “Editing tool for exchange files” on page 111.

Importing translated texts

When you receive a file containing the translated texts, you can open the file by 
clicking the Import translated texts button. You now enter the dialog box Open, 
where you select the file containing the translations, and click on Open.
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Creating the translated project

When all project texts are translated, click on Create project. Hereby a new project 
is created, containing the translated texts.

If not all texts in the original project have a translation, you will be informed about 
this, and no new project will be created.

In other words: You will not be allowed to create a new project, before all project 
texts have a translation.

Creating a new dictionary

If no dictionary is created for the applied languages, you will be asked whether to 
create a such, when you click Create project.
Automation Tools

age 104



PC|SCHEMATIC Text Translator

Auto
EDITING DICTIONARIES

The dictionaries in PC|SCHEMATIC Text Translator can be used simultaneously 
by multiple users. To edit a dictionary, you must enter the Dictionary dialog box.

To enter the Dictionary dialog box, click the Dictionary button in the Translations 
dialog box, or select a dictionary in the Dictionaries dialog box, and click Open.

In the Dictionary dialog box, you have the following options for editing a dictionary:

Edit, Find and Replace

The functions Edit, Find and Replace functions as described in “The Translations 
dialog box” on page 100.

Updating the dictionary

When you click the Update button, the dictionary is updated with the changes 
made by other simultaneous users.

Adding a new line in the dictionary

Click the Add button, and a new line is added to the dictionary. Type in a new text 
and a translation as well, if possible.

Deleting a line from the dictionary

Click on the line you wish to translate, and click the Delete button.

Edit texts

Find and Replace

Update

Add line

Delete line

Import translations

Export
Create new
column
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Export and Import

The functions Export and Import works as described in “The Translations dialog 
box” on page 100.

Adding a new language to the dictionary

To add a new column for a new language, do this:

 1) Click the Add new language column button.

 2) In the dialog box Add new language: Select a new language in the list, and 
click OK.

 3) The new column is now added.

Deleting a language from the dictionary

To delete a language column from the dictionary, 
do this:

 1) Right-click on the header for the column 
you wish to delete.

 2) Click on Remove language.
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OPTIONS FOR THE TRANSLATION

In the dialog box Options, you can for instance specify which type of project texts 
to translate, and which dictionary to use for the translation:

Specify which texts to translate

In the field Texts to 
translate, you select 
which texts to translate — 
as displayed in the figure 
to the right.

Ignore leading/trai-
ling numbers and special characters when translating

When you select Ignore leading/trailing numbers and special characters in 
texts when translating, the PC|SCHEMATIC Text Translator program will 
behave as it did in the previous version of the program. — Read more about this in 
“Numbers, special characters and insertion of variables” on page 112.

Click here

... and select which
text types to
translate
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The Dictionaries dialog box
To control which dictionary to use for the translation, click on Dictionaries in the 
Options dialog box.

You then enter the Dictionaries dialog box, where you can for instance create dic-
tionaries, add/remove dictionaries and edit dictionaries.

If you have more than one dictionary for the same languages — for instance two 
English-Danish dictionaries —, PC|SCHEMATIC Text Translator will use the first 
of the dictionaries in the list.

You can change the position of a dictionary in the list, if you click on it, and then 
drag it to the desired position.

You have the following options:

Opening a dictionary

Click on a dictionary in the list, and click Open. The dictionary is opened in the dia-
log box Dictionary. — See “Editing Dictionaries” on page 105.

Adding a dictionary

Click on Add, and you enter the dialog box Open. Find the file containing the dicti-
onary, and click on Open.

ADDING OLD DICTIONARIES

You can also add dictionaries from the previous version of PC|SCHEMATIC Text 
Translator. — Read more about this in “Converting dictionaries from the previous 
version” on page 115.

Removing a dictionary

Click on a dictionary, and click on Remove. Hereby the dictionary is removed from 
the list of dictionaries. Please note, that the dictionary itself is not deleted.
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Creating a new dictionary

To create a new dictionary, do this:

 1) In the dialog box Dictionaries: Click on Create new, and specify the langua-
ges in the dictionary:

 2) You can only choose one language in the From field, while you can choose 
more than one language in the To field. You can therefore have both an Eng-
lish-Danish and a English-German dictionary in the same dictionary.
When you create an English-Danish dictionary, you can only use it for trans-
lating from English to Danish — and not the reverse. To translate from Eng-
lish to Danish, you must therefore create a Danish-English dictionary.
Click OK, specify where to save the dictionary, and click Save:
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 3) You now enter a new dialog box:

Here you can type in new texts in the dialog box, or import new texts into the dialog 
box, as described in “The Translations dialog box” on page 100.
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EDITING TOOL FOR EXCHANGE FILES

The editing tool Edit exchange file (TXFedit.exe) can be used for editing translati-
ons, originating from a project or from a dictionary.

When you send an e-mail to an external translator (see “Export texts to translation” 
on page 102), and he/she opens the mail containing the texts, he/she simultane-
ously gets the option of downloading this editing tool via a link in the mail:

Edit, Find and Replace

The functions Edit, Find and Replace functions as described in “The Translations 
dialog box” on page 100.

Open file

To open a new file, click the Open button.

Please note, that if a file is already open, this file will be closed automatically when 
you click the Open button.

Save

To save, click the Save button.

Send a file by e-mail

Click the Send mail to mail a file with texts and translations.

— Read more about this in “Export texts to translation” on page 102.

Save
Send file by e-mailEdit and

Find and Replace
Open file
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RECOGNITION AND TRANSLATION OF TEXTS

To get the most benefit of PC|SCHEMATIC Text Translator, it is important to know 
something about:

- how the program recognize texts, and

- how the program translates the texts

This is described in the following.

What does PC|SCHEMATIC Text Translator recognize?

First of all, it is important understand, that the program does not recognize indivi-
dual words, but only texts.

If you have translated the text Conveyorbelt Forwards, this will not enable the pro-
gram to translate the texts Conveyorbelt and Forwards, if they appear separately 
somewhere in the project.

This is because the program understands the text Conveyorbelt Forwards as a 
complex, and not as existing of the two individual words Conveyorbelt and For-
wards.

Correspondingly, if you have translated the text Conveyorbelt at one place, and the 
text Forwards at another, you would still have to tell the program how to translate 
the text Conveyorbelt Forwards.

Why does the translator not recognize a text?

If the translator does not recognize a text, it can be due to one of the following rea-
sons:

- The text is new to the translator

- There is a spelling/typing error in the text

- The text does not follow the company standards for texts in projects

- The translator discerns between upper and lower case letters

If possible, the translator will suggest another text.

Numbers, special characters and insertion of variables

If you in the Options dialog box have selected Ignore leading/trailing numbers 
and special characters in texts when translating, the PC|SCHEMATIC Text 
Translator program will behave as it did in version 9 and previous versions. This 
means that numbers and characters in the beginning and end of texts, will be igno-
red when translating. If the program can translate the text Start motor 1, it will the-
refore also be able to translate the text Start motor 2.

This can, however, be inexpedient if the number in the translation is placed in a dif-
ferent position relative to the text, compared to the original language. The English 
text December 4th should for instance be translated to the Danish text 4. decem-
ber.
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You can therefore insert a variable, so that you can specify where to place the 
number in the translation:

As you can see above, you can use more than one variable in the same line. The 
bottom line translates the date format 27/9-2007 to the date format 2007-9-27.

Variables are inserted in the dictionary

You insert these variables in the dictionary by adding a new line to the dictionary, 
as described in “Editing Dictionaries” on page 105.

If you are in the process of translating a project, you then click the Translate using 
dictionary button in the dialog box Translations, as described in “The Translati-
ons dialog box” on page 100. The project texts are then translated again, this time 
using the inserted variables.

The dictionaries can only translate in one direction

In PC|SCHEMATIC Text Translator, the dictionaries can only translate in one 
direction. When you create an English-German dictionary, you can only use it for 
translating from English to German — and not the reverse. To translate from Ger-
man to English, you must therefore create a German-English dictionary.

A dictionary can translate To multiple languages

You can use a dictionary in PC|SCHEMATIC Text Translator to translate to multi-
ple languages. This way, you can for instance have an English-German and an 
English-Polish dictionary in the same dictionary.

— See how to create a new dictionary in “The Dictionaries dialog box” on 
page 108, “Creating a new dictionary” on page 109 in particular.
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HOW TO PLACE TEXTS IN A PROJECT MEANT FOR TRANSLATION

When you are working on a project, and know that it is going to be translated at a 
later stage, it is a good idea to be careful about how to place the texts in relation to 
the lines and the symbols of the project. This is because some texts in the new lan-
guage will turn out to be longer than the texts of the original language. If you have 
placed some of the texts inexpediently, they will overlap with symbols or lines in the 
project.

You specially have to be careful when you place the symbol texts. If you place them 
on the left-hand side of the symbol, they might overlap the symbol after the transla-
tion. If you place them on the right-hand side of the symbol, however, the texts are 
written in a direction going away from the symbol.

Alternatively, you can place the texts on the left-hand side of the symbols, but set 
the text alignment to be right justified. You can read more about text alignment in 
the Automation manual.

Expedient Inexpedient
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CONVERTING DICTIONARIES FROM THE PREVIOUS VERSION

If you have used version 9 or previous versions of PC|SCHEMATIC Text Transla-
tor, you will be asked whether to convert the previously applied dictionaries to the 
new format, when you start PC|SCHEMATIC Text Translator:

Click Yes to create new dictionaries based on the old.

You now enter the dialog box Convert:

Now select the correct languages in the right side of the dialog box, and click OK.

In PC|SCHEMATIC Text Translator you can only use the dictionaries to translate 
in one direction, as described in “The dictionaries can only translate in one direc-
tion” on page 113. This was not the case in the previous version.

This means that you can create several different dictionaries based on the previous 
version. You therefore enter this dialog box, where you specify which dictionaries to 
create:

Select which dictionaries to create, and click OK.
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You then enter the following dialog box, where you specify where to save each indi-
vidual dictionary:

You can then see the new dictionaries added at the bottom of the list in the dialog 
box Dictionaries:

— Read more about the options you have here in “The Dictionaries dialog box” on 
page 108.

NUMBERS AND SPECIAL CHARACTERS ARE HANDLED DIFFERENTLY NOW

NUMBERS AND SPECIAL CHARACTERS ARE HANDLED DIFFERENTLY IN THIS 
VERSION OF PC|SCHEMATIC Text Translator, AS DESCRIBED IN “NUM-
BERS, SPECIAL CHARACTERS AND INSERTION OF VARIABLES” ON PAGE 112.
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Other options in the Tools menu

In the Tools menu in PC|SCHEMATIC Automa-
tion, you will also find the follownig options:

• Rename symbols
Read more about this in the PC|SCHEMATIC 
Automation manual.

• Database
Read more about this in the PCschematic Data-
base manual.

• Create variable list in (Sub)drawing
Read more about this in the PC|SCHEMATIC 
Automation manual, and in the Project Generator 
manual.

• Project generator
Read more about this in the Project Generator 
manual.

• Mouse Chasing System
Read more about this in the PC|SCHEMATIC 
Automation manual.

Other options in the Tools menu
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